Tutorial

**SIOX plugin in ImageJ: area measurement made easy**

Fang Wang, ORCID: 0000-0001-5714-0010
ViPS, Department of Biosciences, University of Helsinki, Helsinki, Finland
DOI: 10.19232/uv4pb.2016.2.11 © 2017 The Author, licensed under

**Introduction**

Area measurement is frequently needed in research. ImageJ is a powerful free image processor for this purpose and resolves the measurement in a simple way. However, the advantage of the countless functions from ImageJ may be seen as confusing by beginners. One frequently asked question about area measurement is how to select the region of the image to be quantified, as a good area estimate depends on the accurate segmentation the object of interest from its background.

Segmentation can be defined as finding the boundary between the object of interest and its background. To do the segmentation manually for a leaf whose area is to be measured, one needs to trace its contour. Here I discuss how to automate this process through image processing.

ImageJ (Schneider et al. 2012) is a powerful image processor, focusing on scientific imaging analyses. It is free open source, written in Java language, which offers the convenience and possibilities for developments of plugins for different purposes. In 2009, development of ImageJ2 was initiated. Fiji (Schindelin et al. 2012) is a software distribution that consists in ImageJ2 (Schindelin et al. 2015) with many additional plugins preinstalled. ImageJ2 is mostly compatible with ImageJ1 supporting the use of both old and new plugins.

In this short guide, two alternative methods for object segmentation are described:

- a) automated extraction with plugin SIOX (Simple Interactive Object Extraction) and b) manual threshold selection. Sample images are shown in original form and after the different processing steps so as to facilitate a better understanding for these two methods. This article can also serve as an introduction to the subject when the intention is to use automated methods like that provided by the ImageJ plugin Rosette Tracker (Vylder et al. 2012).

**How to start**

Area measurements such as the calculations of leaf area or infected area are often needed in biological research. Typically, this calculation is fulfilled by 4 steps: 1. Take a photograph that includes the target object on an uncluttered and highly contrasting background; 2. Define the scaling: the conversion factor between pixels (the actual units that are counted in the photograph) into a unit that has actual meaning to the user (e.g. millimetres); 3. Segment the object from the background; 4. Count the pixels in the segmented object and convert this count into the quantity of interest.

These steps indicate some key elements of a successful calculation: a good photograph, a good segmentation and a good conversion. Once you have obtained a good photograph of the object, ImageJ then will do the other jobs.

Some years ago, I wrote a blog post, intro-
SIOX

This section describes step by step how to use the SIOX plugin using a photograph of an Arabidopsis rosette as example. Fig. 8.1 shows the image in ImageJ at key steps in the processing. In the instructions below, italicized texts indicates menu selections in ImageJ.

A1 Import image (of an Arabidopsis rosette in this example). File > Open or drag the image into Fiji window.

A2 Set scale (Figure 8.1a). Select straight line tool on tool bar. Drag a line along one side of the red square in the image. Analyze > Set Scale. Known Distance is the length you dragged which is 3 cm. Tick “Global” for applying this scale to all the images generated from the sample image.

A3 Segmentation (Figure 8.1b,c,d). Plugins > Segmentation > SIOX: Simple Interactive Object Extraction. Use Rectangular/Oval/Polygon/Freehand tool to select a small area on the leaf area to be marked as known as Foreground. Press Segment. Create Mask.

A4 Calculation. Analyze > Analyze Particles > Display Results/Summary.

Achieving a better result

Scale

The red cube in the sample image is the scale to convert pixel of the image into the unit for the area measurement which is centimetre in our example. Many factors in photographing can distort the shape and size and sharpness of the reference scale. For instance, the depth of image or the distortion by the camera lens. To keep it simple, the object used...
Figure 8.1: The steps of segmentation using SIOX: a) set scale; b) set foreground; c) refine the selection; d) the result of segmentation.
as a reference scale should be located at the same distance and position from the camera as the target object. In other words, the two of them should be at the same vertical distance to the camera, and the reference parallel to the sensor or film plane of the camera. A copy stand is essential in many senses. It helps to stabilize the camera and strictly controls the level of the camera (Figure 8.3). Rarely leaves will be laying flat on the ground, so what is estimated with the methods described here is area of the leaves or rosette projected onto a reference plane. It also follows from this that some leaves or parts of the leaves in an intact plant will be nearer the camera than others. This source of uncertainty is usually tolerable for rosettes, but not for plants with stems. This problem does not affect individual leaves scanned or photographed laying on a flat surface.
Colour channels

Images taken with colour digital camera consist in three separate channels of red, green and blue (RGB) sensor readings that when displayed or printed trick the human eye to see something similar to the photographed object or scene. In other words, normally the colors are mixed by our human brain. One way of obtaining a grayscale image is to display the luminosity values for a single color channel (see Figures 8.2 and 8.4). Technically, if we combine the three images of corresponding to the red, green and blue channels (Figs. 8.2b,c,d), we can reconstruct the original colour image of the rosette (Fig 8.2a). Splitting the colour channels doesn’t change the pixel resolution of the image. Thus, the scale we defined in step A2 is valid for all the images derived from the same original image of the rosette (Fig. 8.2a). Thresholding can only be applied to grayscale images. That is why we have to split the channels (or alternatively merge them) first. The easiest segmentation through a threshold is to classify pixels into two output categories of black and white (i.e. convert a scale with many different luminance levels, or tones of grey, into a binary scale by use of a luminance level threshold at at chosen position along the grey scale). For the example image, I choose the blue channel because it is the channel with largest difference in luminosity between the rosette and the background. Other images may require the segmentation of one of the other channels.

Single channel threshold is ideal if the objects have large differences in color between the areas to be segmented. This is the case in the image of tulips taken under room light with a DSLR (Digital single-lens reflex) camera (Figure 8.4). The red flowers and green leaves have high luminosity (look white) in the red and green channels, respectively, while in the blue channel they cannot be distinguished. After splitting the three colour channels into separate greyscale images, the channels suit-

Figure 8.4: A digital image of tulips and its three colour channels: a) the original picture; b) the red channel; c) the green channel; d) the blue channel.
Figure 8.5: Digital image in UVA region of a dandelion (*Taraxacum* spp.) flower. Light source: 365 nm from LEDs; camera: E-M1, Olympus, Japan, converted to “full-spectrum” by DSLR AstroTEC, Engen, Germany; filter: U-filter, Baader Planetarium, Mammendorf, Germany; objective: “accidental” UV transmitting Hannimex 35mm f/3.5 No. 13368)

The dark area at the centre of the flower, visible only under UVA illumination, is of interest as it is visible to insects such bees even if not to humans. The luminosity of the different color channels in the absence of visible light is only the result of their different sensitivities to UV radiation rather than their designed differences in sensitivity to visible colours. The weak colour visible in the image is “false” as it is unrelated to human color vision. However, segmenting this area with the SIOX plugin is almost impossible because there is little difference in color. In contrast, thresholding on the separated colour channels returns very good results as there is a difference in luminosity. However, one should...
Table 8.1: Dark areas for dandelion flower. Selection tool Oval was used for selecting the area of interest. Under the tool icon, x and y indicate the center location of the oval area on the image; w and h indicate the width and height of the oval that determine the oval area. To ensure the same location and the same size of the selected area in each channel, the parameters of x, y, w and h used were exactly the same. The dark area is expressed both as number of pixels, and as a percent of the selected area.

<table>
<thead>
<tr>
<th>Image channel</th>
<th>Dark pixels (number)</th>
<th>Dark area (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>blue</td>
<td>2032379</td>
<td>48</td>
</tr>
<tr>
<td>green</td>
<td>1378071</td>
<td>36</td>
</tr>
<tr>
<td>red</td>
<td>1416709</td>
<td>40</td>
</tr>
</tbody>
</table>

Bear in mind that the size of the selected dark area will depend on the value chosen for the threshold and on the channel used. Figure 8.6 shows an example of thresholding on the red channel. In this image it is very clear that thresholding also selects a large section of the background. Before quantification, the area of interest at the center of the flower must be isolated with a mask drawn by hand. Drawing the mask is easy, as the white area separating the center of the flower from the background is very wide.

With the threshold set similarly for each single channel image the area estimates vary (Table 8.1). The area estimate for the blue channel is larger for than the other two. This is most likely due to differences in spectral sensitivity within the UVA region of the three channels of the camera’s image detector. In Table 8.1 the areas are expressed in pixels as there was no size reference available. One could estimate the total area of the inflorescence and express the dark area as a ratio. We leave this as an exercise for the reader to try (The images are provided as supplementary information for readers to practice on.)

Further reading

This article gives a simple introduction to the most basic method of area estimation. The process of area segmentation can be automated within ImageJ and used to measure growth and other temporal changes in plants. The Rosette Tracker plugin (Vylder et al. 2012), available at http://telin.ugent.be/~jdvyn/er/RosetteTracker/ together with its documentation provides the next step in sophistication when using time lapse imaging. A recent comparison of methods shows that consistency of quantification is not easy to achieve (Scharr et al. 2015), highlighting the need for careful protocol design and use. The ultimate in cost as well as throughput are automated plant phenotyping systems. Other plugins for ImageJ allow different approaches to the quantification and measurement of different biological structures at scales ranging from subcellular to aerial images. There is a lot more to explore, and a good way is to read both scientific publications and less formal technical reports. You can read the essay at http://alvyray.com/Memos/CG/Microsoft/6_pixel.pdf if you would like to understand more about pixels (or voxels). For further information on ImageJ you can read tips on its use at http://imagej.net/Category:Techniques. For a simple, modern and accurate account of technical (and artistic) aspects of digital photography you can read the two volumes Learning to Photograph (Banek and Banek 2013a; Banek and Banek 2013b).

Acknowledgements

I thank Pedro J. Aphalo for supplying the UV image and critically commenting on the manuscript.
References


Peer-reviewed article.
Published on-line on 2017-02-01.
Edited by: Marcel A. K. Jansen.

Our Tutorial articles distil existing information into an easy to follow set of instructions to perform a specific research-related task. The contents is not required to be scientifically original, but it should not duplicate other readily available tutorials. The article above is a good example of the type of submissions we hope to receive under this category. We invite all our readers to submit similar tutorials for techniques they are experts in. These techniques can include from chemical assays in the laboratory to measurements in the field. For complex subjects, we are also happy to publish tutorials in installments over several Bulletin issues, as long as each installment is readable and useful on its own.

The editors.